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Overview

The IBM Mobile Test Workbench
for Worklight® provides several
unique resources to test Worklight
applications.

With the test workbench, you can
create functional tests for IBM
Worklight hybrid and native
applications running on iOS or
Android.

The test workbench creates tests in
a natural language, and provides
visual test editing.

The test workbench runs within
Eclipse, and is integrated with
Worklight Studio.
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Overview — continued

The testing approach with the test workbench consists of four stages:

Recording: You first play your test with the recording-ready app,
and generate a test script.

Authoring: You edit and enhance the test script by adding
verification points and others instructions.

Playback: You run the test script on a real device or a simulator.
Reporting: You generate an HTML report.
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Installing and configuring

To use the IBM Mobile Test
Workbench for Worklight, you must
install an Eclipse plug-in into an
exisiting instance of Worklight Studio.

In Worklight Studio, use Help >
Eclipse Marketplace, and search for
Worklight.

When you locate the IBM Mobile Test
Workbench for Worklight, click
Install.

Note that both Worklight Studio V6.0
and IBM Mobile Test Workbench for
Worklight run in Eclipse 4.2.2 (Juno).

New installations of IBM Mobile Test
Workbench for Worklight require the
latest version of Worklight Studio.

Eﬂ Eclipse Marketplace

Eclipse Marketplace

Select solutions to install. Press Finish to proceed with installation.
Press the information button to see a detailed overview and a link to

]

Search | Recent | Popular | Installed|
Find: |1t &, /7 | [All Markets

v] IAII Categories

7 6]

e IBM Mobile Test Workbench for Worklight Share @

IBM Mobile Test Workbench for Worklight is an automated functional
testing feature for Andreid and 105 native and hybrid applications

developed with IBM...
by IBM, Commercial - Free Install
Meobile developers ibm app Studio

@ IBM Worklight Developer Edition Share @

IBM Waorklight, for eclipse June 4.2.2 (5R2), simplifies the development
of mobile web, hybrid, and native applications across multiple mobile
platforms, including...

by IBM, Commercial - Free Install

Mobile developers ibm app Studio

B 9o

oy
(2 < Back Mext > Finish
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Installing and configuring — continued

After the test workbench is installed, you can see that a new Test
Workbench perspective is available in Eclipse:

=] | ‘l‘-is' Java EE f Design ||Eﬁ Test Workbench |L|:-| Fesource

Also note the following icons in the Eclipse toolbar:

| opens the Mobile Applications view. This view lists all the

applications that are available for testing.

d| opens the Mobile Devices view. This view lists the devices
that you use to test your application.
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The mobile client

With the mobile client application, you can record tests, run test playbacks,
and view reports on the mobile device.

This mobile application must be installed on a real device or on a simulator.

The mobile client communicates with the test workbench to install
applications, to store test scripts, and to test results. Note the Workbench

URL in the Mobile Devices view.

m Mobile Devices

Mobile devices
List of available mobile device in workspace

Enter filter text [E] & I B

10

No device selected

No device selected, add one to workspace:
B

To add a device, the mobile client must be installed and running
connected to a network with access to this computer.

Workbench URL (9.128.82.21:7878/mobile
QR Code:

5

[=]

1) To download and install the mobile client on the device, either
scanner app or open a web browser on the device and browse to -
2) To connect the device to the workbench, run the mobile client
barcode butten to scan the QR code or tap Settings to enter thew
‘/mobile’).

[
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Installing the Android mobile client

To install the mobile client on an Android device or a simulator:

Use the QR code that is available in the Mobile Devices view to
open an installation page on the device.

E: Mobile Devices

Mobile devices
List of available mobile device in workspace

Enter filter text rg"l l B | %

| @ E

12

No device selected

No device selected, add one to workspace:

B

To add a device, the mobile client must be installed and running
connected to a network with access to this computer,

Workbench URL: | htp://9.128.82.21:7878/mobile

QR Code:

1) Te download and install the mobile client on the device, either
scanner app or open a web browser on the device and browse to-
2) To connect the device to the workbench, run the mobile client
barcode button to scan the QR code or tap Settings to enter the w
‘/maobile].

R T 3
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Installing the Android mobile client — continued

= On the device, the QR code opens a page that displays installation
instructions:

T=s IBM Rational Test Workbench

Rational Test Workbench - Android Welcome Page

1 Allow 'Unknown Sources' in Settings| Applications (Android 2.x to 3.x) or
Settings | Security (Android 4.x)

2 Download and install client application, for Android:
Click here to start download

Follow this link for more information

— Follow the instructions to download and install the mobile application on
your Android device.
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Installing the Android mobile client — continued

14

When the IBM Rational Test
Workbench application is installed
on your device, start the
application.

You start by configuring the
address of the test workbench in
the Workbench settings section.

The URL is the same as the URL of
the page opened by the QR code,
without /7mobi le at the end.

The URL has the following
structure: http://<your-ip-
address>:7878

@@L+ LI A =2 al B 1507
IBM Rational Test Workbench - Settings
Workbench settings

Address

URI of the workbench [""]

Type your username [""]

Password
Type your password [""]

Parameters

Use SD card

Save temporary files to the SD card

Auto refresh

Enable auto-synchronization with the
workbench
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Installing the Android mobile client — continued

If the connection is correctly established, you can see the connection icon at

the bottom of the screen.
@+t AT < B al B 075
IBM Rational Test Workbench Mabile Client

Configure Workbench
["http://9.128.82.21:7878"]

Manage Applications g

Install, record, or test your apps

Upload Application <l
p pp m
Upload and prepare apps that you warkotest

Switch to passive mode
Workbench controls test execution A

Disconnect

Disconnect from workbench
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Installing the 1I0S mobile client
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On iOS , the mobile client is a web
application that runs in the Safari or
Chrome browser on your device.
To run the client, type the
Workbench URL in the following
format, in a browser on your
device:

When using the mobile test client
on an iOS device, make sure to
enable pop-up windows. Pop-up
windows must be allowed for the
Workbench IP address. Safari
silently disables pop-up windows,
and Google Chrome prompts you
to allow pop up windows.

IBM Rational Test Workbench Mobile
Client

Applications

¥ Manage applications >

@ Manage web applications

Mode

/) Enter passive mode >
Help

7 ) Help >
£-3 About >
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Creating a test project

19

= To start testing an IBM Worklight application, you must create a test project.

= You can create your test project at the same time as you create your IBM
Worklight project, by clicking IBM Mobile Test Workbench in the New
Worklight Project dialog, and by selecting Create a Test Project.

Hybrid Application

Hybrid Application
(EIBM Mohile Test Work...

Application name:
MyHybridApp
jQuery Mobile Installation
[#] Add jQuery Mobile

The Worklight runtime provides jQuery Core. Select the jQuery
Mobile resources you would like to import:

Configure the hybrid application that will be created along with the Worklight project. W

Location:  C\jquery.mobile-13.1zip =6

|=| jguery.mobile-1.3.1.css
12| jquery.mobile-1.3.1js
[T = iauerv.mobile-1.3.1.min.css

-

= sss

Dojo installation
[] Add Dojo Toolkit

a Dojo library project centaining a full Dojo to supplement the
layers:

Sencha Touch Installation
[ Add Sencha Touch

Location:

dojolib New Dojo Library

Meobile-optimized Dojo layers will be added to the project. Select

Next > [ Finsh [ cancel

{ @ New Worklight Project - ' ===

IBEM Mobile Test Workbench
Create a new Test Workbench project to test your thplication W

Hybrid Application
{IEM Mobile Test Work... [¥] Create a Test Project
Project Mame:  MyWorklightProjectTest
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Creating a test project — continued

= You can also use File > New > Test Workbench Project to create a test

PrOIECL (Greroe T

Create a Test Workbench project

-

(1) Project location directory must be specified

U

Project name:

[] Use default location

Location: Browse...

Choose file systemn:

© T
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Preparing the application for testing

Before you can test an IBM Worklight hybrid application, you must
make sure that:
(If you test an Android app) You created the native Android project in Worklight

Studio by clicking Run As > Build Android Environment, and you created the
application binary (the APK file) by using the Android tools.

For more information about Worklight Android applications, see the module
Previewing your application on Android, under category 2 of the tutorials.

(If you test an iOS application) You created the Xcode project in Worklight Studio by
clicking Run As > Build IPhone Environment, and the appropriate certificate is
specified in the Xcode project in case you want to test on a real device.

For more information about Worklight iOS applications, see the module
Previewing your application on iOS, under category 2 of the tutorials.

You performed a build and deployment action on your project by right-clicking the
project name, and clicking Run As > Run on Worklight Development Server.
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Preparing the application for testing — continued

— Right-click the android, iphone, or ipad environment in your IBM
Worklight application, and click Run As > Test with IBM Moblle

Test Workbench.

23

(O
File Edit Navigate Search Project Run Window Help
= iy havsecd e R PRSI S O R G e e R 1R |
CR. - Quick Access £ | [(3 Java EE | @ Design
[ Project Explorer 52 = m 5 H| Mobile Device ) Mobile Appli... 52 ™ = = 5 Outl.. 52 SEH '5‘, |
I &le ~ i bil licati e 7@
(& Worklight Development Server | Mobile Applications An outlineis not available.
4 ) WorklightTestProject e e ey
=i WebSphere Application Servi ooile applications application se
3 List of available mabile applications in
b mh WL Server Library b,
=i JRE System Library [jre]
G serverfjava No Application, add one to workspace
- m JavaScript Resources
B adapiery Enter filter text a
4 = apps
PE= MyWDrkhghtProject
New 3
Golnto
ShowIn Alt+Shift=W »
b @ bin & Copy Ctrl+C
(= compone| 2 e
% ol = Copy Qualified Name
» 2 WorklightTes (15 Paste Ctrl+V
2 WorklightTes 3 Delete Delete
Remove from Context Ctrl+ Alt=Shift+ Down
Build Path »
Move...
Rename... F2
a5 Import..
4 Export.
&7 Refresh £5
@ Bdract public signing key
Validate
Show in Remote Systems view 1
Run As » |5 1Build All and Deploy Alt+Shift+R, B
Debug As » 2 Build Environment and Deploy |
Profile As v 3 Build For Remote Server.. =B
Compare With b @ 4Preview Berg~
Restore from Local Histary... ‘ @ 5Preview...
Team HR)
P o — e , | @ 7 Test with BM Mobile Test Workbench...
4= android - Workligh Properties
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Preparing the application for testing — continued

You can now see the test-ready application in the Mobile
Applications view in the test workbench, and on the mobile client.

D Mobile Applications

Mabile applications MyWorklightProject
List of available mobile applications in workspace Application File
Enter filter text o= E R @l |8 % Abplicatian
‘ o

(c;-. MyWorklightProject 1.0 p‘

1|« Availsble @ Android | .‘ﬁ My WorklightProject
s

&

The status of the application must be Available in the Mobile
Applications view before you can start recording a test.
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Creating a test

To start recording a test on the Android client: select the application in the list
of managed apps, and click Record in the mobile client on the device.

To start recording a test on the iOS web client: select the application in the
list of managed apps, install the app on the device by clicking the Install
button. When the installation is completed, click Record.

----- Bouygues & 10:55 B
9.128.78.169 ()
<App|icat\ons @ G
Orig ec Clear
2 MyWorklightProject MyWorklightProject
@‘ Version: 1.0 27 novembre 2013 10:55:00 UTC+1
B Date: Jul 15, 2013 12:41:39

btatus: Original app

berver status: Available Tests

&

< m @
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Creating a test — continued

27

The application runs on the device or emulator.

Everything you do with the application is recorded and sent to the test
workbench. For example, the script records the moment when you press a
button, or enter text in an entry field.

Close the application to stop the recording using the Home (i0S) or Back
(Android) buttons.

A message indicating the availibility of a new recording is displayed on the
test WOI’kbenCh ® (i) There is a new incoming recording. 52

Click here to generate a test.

Follow the wizard instructions to generate a test from the recording. You will
be asked to store the test in the test project.

For more information about how to create a test, see the IBM Worklight user
documentation at:
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Editing a test

= After the recording, you can edit the test in the natural language

editor.

B Navigare B Test Dat
k2l _obii
¥ |=f Remate Syitems Tampfiled

L Werlight Develogmen Server
& §worklight TestFropect
* o Workiight TeaPrajeat Test

LT

[@anterCredantial

[l Mttork g hiProject- L0~ iphone
= Rl Motile Devices

Farers: [ Launch agsiics

= O [ Mobile Applicat

B v

Teit - enterCredential

Tedt Cofilfig
Enter filrer tewt

w [ eeaerCredentul
o] Ten Resources
* [ Lsunch

¥ ]
Ok on pluscy bnpe Nald whoss Ty

[3 Eor teat ‘bshn’ in joheery input flabd

(3 Ervter tewt PASSWORDY in Jwery Inps]
[ Evnr text PASSWORLY in jChsery Inps,

&

[ Eoter nest Semieh’ in puery bnput fiel

HMMMMHM u:m:___

" Recordling Contral &

iy~

Ko achive feceeding sedsion

Wi Mobile Devices  [Tapplicaion-ces % emerCregential 5 %

at the spectied index
Thislk time {millisscondal. 3125
& Time out (secondik 1n

* promlems D] Conscle (B Mobile Data B =0
EBsereen Capture | [ Demer | L Properties of JGuery Input
g-rmall .;'ltl-li.r-q:r-f;.-.\\_; 1

—

Clags
Canpest
kCoordinaies.
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Editing a test — continued

= You can edit the test to insert verification points (for example, to verify the value of a
user interface element), to replace recorded test values with variable test data, or to
add dynamic data to the test.

Test Contents Test Element Details
[Enter filter text i | z
T 2 | Opticns » Graphic ohject: | JQuery Input field
v %E enterCredential Add y _ —
b 5] Test Resources Object's action: | Click
¥ [ Launch application: MyWorklightProject I | | A =
- = b | 2
= Click on JQuery Input field whose Ty Select ectarantingd D m»
. - oy |l
Eﬁ Enter text Ijohmi@_&mycumpany.cum_ in bject location: pre——r
'E‘?, Enter text ‘John' in JQuery Input field Remove |
[ Enter text 'Smith' in JQuery Input fiel, ~ Think time (milliseconds): 3125
T3 Enter text 'PASSWORD' in JQuery Inpu i
P @ Time out (seconds). 30

fa Enter text 'PASSWORD' in JQuery Inpu
L__3 Click on JQuery Button located at pos|| Down

View | B )
= For more Inf0||||uuun AN UUIL 1TUYVYVY LU UL LTTw Lu UL gmt;'u’i\, IIVI VVVUI I\Ilﬂllt Uuoavwli

documentation at:;
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Running a test

= Run a test to ensure that the app
matches the expected behavior
that is defined in the verification
points.

= During the test, each verification
point is checked, and receives a

pass, fail, or inconclusive status.

= The available tests are visible in
the mobile client, and you can run
the test from this application.

32

esesee Bouygues = 11:10 = #
9.128.78.169 C
¢ MyWorklightProj ®@
SimpleTest

k] SimpleTest (last modified on:27

s novembre 2013 11:09:19 UTC+1)

MyWorklightProject

Application: (version:1.0; created on:27 novembre

2013 10:53:57 UTC+1; imported on:27

novembre 2013 10:55:00 UTC+1)

|'|'ac1

&

Test Reports

< M O O
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Running a test — continued

After the test is completed, a report is generated and shows the status of
the test and all the verification points.

You can read the report on the device, or on the Eclipse test workbench.
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What's Next

In this module, you learnt how to set up and install the IBM Mobile
Test Workbench for Worklight, and how to record a first test and run
a playback.

For more information about IBM Worklight functional testing and the
IBM Mobile Test Workbench for Worklight, see the IBM Worklight
user documentation at:

35 © Copyright International Business Machines Corporation 2013, 2014. All rights reserved.


http://pic.dhe.ibm.com/infocenter/wrklight/v6r1m0/topic/com.ibm.worklight.mobtest.doc/topics/c_wl_mobile_test_ovw.html
http://pic.dhe.ibm.com/infocenter/wrklight/v6r1m0/topic/com.ibm.worklight.mobtest.doc/topics/c_wl_mobile_test_ovw.html

Notices

36

Permission for the use of these publications is granted subject to these terms and conditions.
This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that only
that IBM product, program, or service may be used. Any functionally equivalent product, program, or
service that does not infringe any IBM intellectual property right may be used instead. However, it is the
user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document.
The furnishing of this document does not grant you any license to these patents. You can send license
inquiries, in writing, to:

- IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual
Property Department in your country or send inquiries, in writing, to:

- Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer
of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication. IBM
may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this one)
and (i) the mutual use of the information which has been exchanged, should contact:

- IBM Corporation
Dept F6, Bldg 1
294 Route 100
Somers NY 10589-3216
USA

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by
IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any
equivalent agreement between us.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs.

Each copy or any portion of these sample programs or any derivative work, must include a copyright notice
as follows:

- © (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs.
© Copyright IBM Corp. _enter the year or years_. All rights reserved.

Privacy Policy Considerations

IBM Software products, including software as a service solutions, (“Software Offerings”) may use cookies
or other technologies to collect product usage information, to help improve the end user experience, to
tailor interactions with the end user or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings can help enable you to
collect personally identifiable information. If this Software Offering uses cookies to collect personally
identifiable information, specific information about this offering’s use of cookies is set forth below.

Depending upon the configurations deployed, this Software Offering may use session cookies that collect
session information (generated by the application server). These cookies contain no personally identifiable
information and are required for session management. Additionally, persistent cookies may be randomly
generated to recognize and manage anonymous users. These cookies also contain no personally
identifiable information and are required.

If the configurations deployed for this Software Offering provide you as customer the ability to collect
personally identifiable information from end users via cookies and other technologies, you should seek
your own legal advice about any laws applicable to such data collection, including any requirements for
notice and consent. For more information about the use of various technologies, including cookies, for
these purposes, see IBM’s Privacy Policy at and IBM's Online Privacy
Statement at the sections entitled “Cookies, Web Beacons and Other
Technologies” and the “IBM Software Products and Software-as-a-Service Privacy Statement” at
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For the entire IBM Worklight documentation set, training material and online forums where you can post questions, see the IBM website at:

Support

Software Subscription and Support (also referred to as Software Maintenance) is included with licenses purchased through Passport
Advantage and Passport Advantage Express. For additional information about the International Passport Advantage Agreement and the
IBM International Passport Advantage Express Agreement, visit the Passport Advantage website at:

If you have a Software Subscription and Support in effect, IBM provides you assistance for your routine, short duration installation and
usage (how-to) questions, and code-related questions. For additional details, consult your IBM Software Support Handbook at:

Comments

We appreciate your comments about this publication. Please comment on specific errors or omissions, accuracy, organization, subject
matter, or completeness of this document. The comments you send should pertain to only the information in this manual or product and
the way in which the information is presented.

For technical questions and information about products and prices, please contact your IBM branch office, your IBM business partner,
or your authorized remarketer.

When you send comments to IBM, you grant IBM a nonexclusive right to use or distribute your comments in any way it believes
appropriate without incurring any obligation to you. IBM or any other organizations will only use the personal information that you supply
to contact you about the issues that you state.

Thank you for your support.
Submit your comments in the IBM Worklight Developer Edition support community at:

If you would like a response from IBM, please provide the following information;
Name
Address
Company or Organization
Phone No.
Email address
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Thank You

7 March 2014 © Copyright International Business Machines Corporation 2013, 2014. All rights reserved.
US Government Users Restricted Rights - Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.



	IBM Worklight V6.1.0�Getting Started
	Trademarks
	Agenda
	Overview
	Overview – continued�
	Agenda
	Installing and configuring
	Installing and configuring – continued�
	Agenda
	The mobile client
	Agenda
	Installing the Android mobile client
	Installing the Android mobile client – continued�
	Installing the Android mobile client – continued�
	Installing the Android mobile client – continued
	Agenda
	Installing the iOS mobile client
	Agenda
	Creating a test project
	Creating a test project – continued
	Agenda
	Preparing the application for testing
	Preparing the application for testing – continued
	Preparing the application for testing – continued
	Agenda
	Creating a test
	Creating a test – continued
	Agenda
	Editing a test
	Editing a test – continued�
	Agenda
	Running a test
	Running a test – continued�
	Agenda
	What’s Next
	Notices
	Support and comments
	Thank You

